WMS 11.1 Tutorial
GSSHA — Modeling Hurricane Sandy

Learn how to integrate the outputs of two hydraulic models, the ADvanced CIRCulation
(ADCIRC) model and the Gridded Surface Subsurface Hydrologic Analysis (GSSHA) model to
simulate compound flooding for Hurricane Sandy.
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This tutorial shows how to simulate compound flooding.
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1 Introduction

See the Modeling Hurricane Sandy Presentation for a summary of the model objectives,
results, and explanation of the input data and creation of the model.

2 Getting Started

Starting WMS new at the beginning of each tutorial is recommended. This resets the data,
display options, and other WMS settings to their defaults. To do this:

1. Ifnecessary, launch WMS.

2. If WMS is already running, press Ctrl-N or select File | New... to ensure that the
program settings are restored to their default state.

3. A dialog may appear asking to save changes. Click Don’t Save to clear all data.
The graphics window of WMS should refresh to show an empty space.

4. Click 3 Open to bring up the Open dialog under the File menu.

5. Change the Files of type to “WMS XMDF Project File (*.wms)”.

6. Navigate to HurricaneSandy\NewYork Begin\ and select “NewY ork.wms” then click
Open to close the Open dialog and import the project file.

7. The project has two rainfall gage locations that are away from the main project area.
You can zoom in to the main project area using the Q Zoom tool.

8. Select the GSSHA coverage in the map data tree to show E"-a Map Data

the boundaries of the watershed. E"—@ Cowverages
i @ GSSHA
9. Use the ™* Get Online Maps tool and select “World - [Z) & Irene Rainfal
Imagery.” Click OK.
il MRS
@ Get Online Maps X

‘World Imag World Street Map

< >
‘1 4 IMPORTANT MOTE: These data sources are on external servers that we have no control over,
t_ el The data may draw/export very slowly or become unavailable at any time. We have no control
? _\&: over this.
_f: 3 Help Advanced... Cancel
v F = 2 R = )
L < ks |
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Figure 1. Initial project.

3 Examine boundary conditions

Let’s look at the boundary conditions of the model. You’ll notice the boundary polygon
is split into two arcs.

1. Inthe + Map Module, using the iy Select Feature Arc tool or the ® Select
Feature Object tool, double-click on the land-side arc. You’ll notice that the arc has
an overland flow boundary condition type of “None”. This means the arc is a no-
flow boundary. This is conceptually equivalent to a parallel-flow boundary.
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@) Properties X
Feature type: |Arcs ~ | Show: | Selected w | Filter Lizing: Column:
Walue: hd
D Type | Groundwater BC | Overland Flow BC Type Variable BEJ

All

’2_ Generic

KIKR

- -
- I Generic - |

-~ =

=

| | Cancel

o

2. Click OK.
Now double-click the NY Harbor-side feature arc.

4. You’ll notice the harbor-side feature arc has a boundary condition type of “Variable
Stage (Water Surface Elevation)”.

@) Properties *
Feature type: |Alcs ~ | Show: | Selected - | Filter uzing: Colurnn:
Walue: A
1] Type | Groundwater BC | Overland Flow BC Type | ‘Wariable BC |
Al ] E K
3 | Genenic | Generic j ariable stage [water surface elevation] j

~
v

I ak | | Cancel

5. Click on the “...” button in the Variable BC column. This will bring up the XY
series editor for the variable stage boundary condition for this arc.

@ XY Series Editor

*

Time: Stage e... a0 | T 1
8/28/2022 B:00:00 Ak 015 T T I‘.
8/28/2022 8:00:00 &M 15 T y
8/28/2022 10:00:00 At 275 T f
8/28/2022 12:00:00 PM 30 |
8/28/2022 2:00:00 P 1.75
8/28/2022 4:00:00 Ph 015
8/28/2022 6:00:00 P 015
8/28/2022 £:00:00 P4 01§
8/28/2022 10:00:00 PM 015 r
8/23/2022 12:00:00 PM 015 i T T '%I

Stage elevation (m)
I ~ "
i A R

=}
=
&n
I

K KN KN KN KN KN KRR RN R K]

GAM  3AM 1ZFM IFM  GFM  SFM 23 Mon 3AM  GAM SAM 12PM
Aug 28 Sun 2022 Time

Curve Name: |Ireﬂeﬁpt1 |

[ Show Dates Selected Curve: |I|ena_pﬂ V|| Mew | | Delete |

6. Note the dates and stages that reflect the storm surge (in meters). This type of
boundary condition will set a uniform value across the entire boundary at any given
time. Note also that the “background” water surface elevation is set to 0.15m.
Because the model doesn’t have bathymetry of the harbor or rivers, this will
effectively try to make a small amount of standing water around the edge. Very
shallow water moves slowly because of the roughness of the bottom, which is not
conceptually appropriate for our model. Thus, trying to add a little bit of water to
cover the lack of bathymetry to start the model will help the model perform better.
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7. Click OK to close the XY series editor and the feature arc attributes dialog boxes.

4 Editing the Project File

The model is reasonably set up as it is, but let’s make it better. To do this we’ll need to
not use WMS as these options have not been implemented in WMS yet.

In the HurricaneSandy folder is a Workspace folder. Inside this folder are two folders,
NewYork Irene and NewYork Sandy. Each of these is just a copy of the
NewYork Begin folder. We’ll work in the NewYork Irene folder.

1. Inthe NewYork Irene folder, use your favorite text editor (TextPad or
Notepad++ are good options) to edit the “NewYork.prj” file. The .prj file is the
project file. It is the control file for the simulation. Each line has the format
[card] [value]. For example, ELEVATION “NewYork.ele” instructs GSSHA to
read the NewYork.ele file as the land surface elevations for the simulation.

GSSHAPROJECT
WMS WMS 11.1.10 (64-bit)

WATERSHED MASK "HewYork.msk"
PROJECT PATH e
$#FROJECTION_FILE "NewYork prj.pro”
HON_ORTHC CHANNELS

FLINE "HewYork.map"
METRIC

GRIDSIZE 75.000000

ROWS 839

COLS sol

TOT_TIME 2960

TIMESTEP 2

OUTROW 605

OUTCOL 466

CUTSLOCPE 0.001000

MARP FREQ 15

HYD FREQ 30

MLF TYPE 1

ELEVATION "HewYork.ele"
DEPTH "HewYork.dep”
FLCOD _GRID "HewYork.gfl"
TIME SERIES_ FILE "HewYork.xys"
OVERTYFE ADE
#INDEXGRID_GUID "anif.idx" "08b4c25e-8640-4e8d-a68f-8bcET2deb010" O
COV_BOUNDARY

$0V_BOUNDARY TSF "New¥ork bc.tsf"
MAPPING TABLE "HewYork.cmt"
STMMARY "HewYork. sum"
OUTLET_HYDRC "HewYork.otl"

PRECIP_FILE "IreneRainfall AugZeEst.gag"”
RAIN INV_DISTANCE

2. First, we’ll edit the outlet row, column, and slope. When GSSHA simulations do
not have a stream network, WMS looks for the lowest cell on the boundary and
makes it the outlet. As we are not running a traditional watershed model, our
outlet as the lowest point (i.e. -
somewhere on our storm surge
boundary) doesn’t make much sense. It
will be better to make the outlet
somewhere else, and then simply make
the outlet slope very flat so that it
effectively does nothing. We’ll use
WMS to get the grid coordinates of a
better cell. In WMS, pick an edge of the
model that is relatively high and use the
zoom tool to zoom into it. For example,
the one shown here.

3. Inthe & Display Options, under

|E D GrdData 51y Grid, toggle on the MCels cells. You’ll see the underlying
GSSHA grid. If you are not zoomed in enough to hover over individual cells
along the boundary, zoom in more.
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4. As you move the mouse around and hover over individual cells, you’ll see the I

and I grid coordinates in the lower right corner changing. You’ll notice the I
changes as you move up and down (row) and J changes as you move left and
right (column). Make note of the I and J of the highest elevation boundary cell
in your area. For the image above, it is Cellinfo: ID: 306421 1:512 120 =512,
J=20.

Back in the project file in the text editor, change the OUTROW to be the I
value, and OUTCOL to be the J value. Change the OUTSLOPE to 0.00001.

CUTECW 512
CUTCCL 20
CUTSLOPE 0.00001000

Now that we have fixed the outlet location, we’ll add the base water level for
the model. At the end of the list of project commands, add a new card: the initial
elevation head value. It looks like this: “INIT ELEV_HEAD 0.15”. This
instructs GSSHA to look across the entire domain, find any surface elevations
that are below 0.15, and set the water depths sufficient that the water surface
will be at elevation 0.15. There are a couple of other ways we could initialize
the water surface elevations. This one is one of the simplest.

NOTE: There are a few rules about the order of the cards in the project file, but
the project file is generally very flexible about the ordering. If you are after the
project path card you will be able to move cards around and not change the
project with only a few exceptions. So you could, for example, organize the
inputs and outputs, or organize by process, or just leave them as they are.

OV _BOUNDARY

#DV_EDUNDARY_TSF "HewYork bec.tsf"

MAPPING TABLE "HewYork.cmt™

SUMMARY "HewYork.sum"™

OUTLET HYDRO "HewYork.otl"™

PRECIF FILE "IreneRainfall AungleEst.gag"”
RATHN THV DISTANCE

INIT ELEV HEAD 0.15

Let’s also turn on overland flow momentum equations. At the end of the project
file add a new line that has “OVERLAND MOMENTUM”.
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10.

11.

12.

OUTLET HYDRO "HewYork.otl"™

PRECTIP FILE "IrencRainfall AugZéEst.gag"
ELIN INV DISTANCE

INIT ELEV HELD 0.15

CVERLAND MOMENTUM

Save the project file.

Let’s also add variable depth manning’s roughness. Open the NewYork.cmt file
in your text editor. We’ll work on the ROUGHNESS index map, the first one in
the file.

GSSHA_INDEX MAP TABLES
INDEX MAP "anif.idx" "unif"

INDEX MAP "NewYork_bc.idx" "NewYork bc"

ROUGHNESS "".:mif"l

NUM_IDS 1

ID DESCRIFTICHL DESCRIPTICHZ ROUGH
1 Roughness ID 0.300000
GREEN AMPT INFILTRATION ""

NUM IDS ©

ID DESCRIPTICH1 DESCRIPTICHZ HYDR COND

To add the variable depth Manning’s roughness, we need to add the exponent as
a parameter to the roughness table. If it is not there, then GSSHA uses a value of
0. To add the parameter, just add a couple of spaces and the exponent value (0.5
is a good starting value) to the end of the roughness value for each ID. You can
add a header, too, if you want. The header lines are ignored by GSSHA.

GSSHA_INDEX MAP TABLES
INDEX MAP "unif.idx" "unif”

INDEX_MRP "Hew¥ork bce.idx" "NewYork bc"

ROUGHNESS "unif™

NUM IDS 1

Io DESCRIPTICNL DESCRIPTICNZ ROTEE

1 Roughness ID 0.300

GREEN_AMPT_ INFILTRATION "™

NUM_IDS O

I DESCRIPTICN1 DESCRIPTICNZ HYDR_COND CARPIL HEAD

GREEN_AMPT TINITIAL SOIL MOISTURE ""

Save the .cmt file and run GSSHA from the command line. If you re-open the
GSSHA project in WMS, and then save the project, you’ll lose these changes.
(The trick, then, is to not save over your project.) Once you run the project you
can read the solution into WMS.

There are two options to run GSSHA projects that have been manually edited.
OPTION A: Command line. To run GSSHA from the command line, open a
command window. In the windows search bar type “cmd” and the cmd.exe app
will appear. Run that app. Use the “change directory” command “cd” to
navigate to the NewYork _Irene folder. The “dir” command is helpful for listing
the contents of a folder so you can see what to type next.

Once you get to the right folder, you’ll need to tell it to run GSSHA. As the
GSSHA executable is likely not in a conveniently placed spot (i.e. somewhere
in your PATH system environment variable) you’ll need to reference the full
path to the executable. The command to run GSSHA for a project is “[gssha
executable] [projectname.prj]”

And if you get and error like this, it is because you didn’t put quotes around

your path with spaces in it. Hit the up arrow and move your cursor back along

the line to add the quotes.
HL,

Without the outlet changes you’ll see outlet flow values in the range of -0.2.
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OPTION B: From WMS. If for some reason you can’t run from the command
line, you can still run GSSHA from WMS. This one is a bit more tricky as it
involves knowing exactly when WMS saves a project. It is highly recommended
to save a copy of your project in another location before trying this option. To
do this option:

A. Open a new WMS.

B. Read in the WMS project or GSSHA project. (Reading in the WMS
project reads in the GSSHA project, and vice versa.)

C. Inthe HH 2D Grid Module, select GSSHA | Run GSSHA

Grids | GSSHA  Hydrographs Window |
| D Open Project File...
J=| Open Group... N
Save Project File ...
Job Control...
Clean Digital Dams...

Precipitation...

g Tree o=

ta Map Tables...
Renumber Links
Renumber Storm Drain
Model Check...

Read Solution...

D. This is the “danger close” action: UNCHECK “Suppress Screen
Printing” and then UNCHECK *“Save File Before Running”.
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G55HA Run Options

Locatian

ﬁ Praject file:

C:Azersh. . Hework. pry
Options
[ ] Suppress screen printing

] 5ave file before running

[ ] Pause G55HA window after running

E. Double check that those are both UNCHECKED.

F. Now select OK. WMS will run GSSHA without saving the project file,
which means your changes won’t be written over. Don’t save the
project file or WMS file. After you run this, just exit WMS WITHOUT
SAVING.

G. Go back to your previous WMS instance or open a new WMS with a

version of the project that doesn’t have your changes. From the HH 2D
Grid Module, chose GSSHA | Read Solution. Navigate to the modified
project file and WMS will read in the results.

Grids | G55HA | Hydrographs  Window

| Open Project File...
o Open Group...

Save Project File ...

Job Control...
Clean Digital Dams...
Precipitation...

3 Tree Mapes

ta Map Tables...

Renumber Links

Renumber Storm Drain

Model Check...
Run GSSHA...

Read Solution...
T e o

5 Add Multiple Overland Boundary Time Series

Another option that we can do is to have multiple time series for the overland boundary
condition. This would be helpful when the overland boundary conditions need to vary
across space as well as time. This also cannot be done in WMS yet. We’ll add it to the
Irene model for now and then explore the file format when we adjust it for Sandy.

1. First, we need to copy the storm surge file from the Data/IreneData folder to the
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Workspace/NewYork Irene folder.

fings * G55HA Training * HurricaneSandy » Data » IreneData v |
Mame Date modified Type
|=| Irene_surge_Adw23 syts.bet 8/26/2011 7:02 PM Text Document
| | IreneRainfall_Aug2GEst.gag 8/26/2011 8:38 PM GAG File

5HA Training * HurricaneSandy » Workspace * MewYork_lrene w | @
Mame Date modified Type
|=| Irene_surge_Adw25_xyts.bet 8/26/2011 7:02 PM Text Docurment
| | IreneRainfall_Aug26Est.gag 8/26/2011 3:33 PM GAG File
| | maskmap 8/29/2022 9:47 PM File
|| MewYork.cmt 8/29/2022 1:38 PM CMT File
|| MewYork.dep 8/29/2022 %:47 PM DEP File

2. Back in your favorite text editor, editing the NewYork.prj file, add the line
“XYBDYINPUT OVDEPTHINTERP "Irene surge Adv25 xyts.txt"”:

PRECIP FILE "IreneRainfall AugZEEst.gag"
EAIN INV DISTRNCE
INIT ELEV HEAD 0.15

COVERLAND MOMENTUM
XYBDYTINPUT CVDEPTHINTERP "Irene surge AdvZS xyts.txt"

This command will signal to GSSHA to interpolate variable stage overland
boundary values from the set of time series in the file rather than use the reference
to the single time series.

8. Save the file and run. If you want to keep your previous results, save the entire
folder to a new location before running. You can close the NewYork.prj text
editor.

6 Hurricane Sandy Forecast Model

When running in forecast mode, the rainfall used in the model will come from another
model. For Hurricane Sandy, the forecast rainfall came from estimating the rainfall amounts
of the Hurricane several days in advance. The storm surge forecast came from ADCIRC runs
several days in advance. We’ll adjust the Hurricane Irene model to use the forecast data.
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Rainfall Rate (mm/hr)

Water Surface Elevation (m)

Hurricane Sandy Forecast Rainfall

25

0

Event Totals
West Side  East Side
517 331 mm
20.35 13.02 inches

N O O £
o8 & RS & & o RS

Y R e 9] 2 o

Oy 3 3 %3 ¥ \)

| o o\ 3 3 N

> & o & & &
D 'S ~ S D B
— West Side — East Side

Advisory 23 Storm Surge

In the Workspace/NewYork Irene folder, select and copy (CTRL-C) the

NewYork.prj and NewYork.cmt files.

iHA Training » FY22 » HurricaneSandy » HurricaneSandy » Workspace » MNewYork_Irene

-~

Name Date modified Type

D IreneRainfall_Aug26Est.gag 8/26/2011 &:38 PM GAG File

D MewYork.cmt 8/29/2022 1:38 PM CMTFile

D MewYork.ele 8/29/2022 1:24 PM ELE File

B MNewYork.map 8/29/2022 1:24 PM Linker Address Map
D MNewYork.msk 8/29/2022 1:24 PM MSK File

IQ{F NewYork.prj 8/29/2022 1:44 PM PRI File

D MewYork.sto 8/29/2022 1:24 PM 5TO File

—_—

In the Workspace/NewYork Sandy Forecast folder, paste (CTRL-V) the files.
When you are asked to replace or skip the files, choose replace.

In the Data\SandyData\Forecast Data folder, copy the two files there.
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wk » Briefings » G55HA Training » HurricaneSandy » Data » SandyData » Forecast Data

Mame Date modified Type

\=| Sandy_ADCIRC_Surge_Elevation_Adv23.bxt
\=| SandyForecastRainfall.txt

Text Document

Text Document

4. Switching back to the Workspace\NewYork Sandy Forecast folder, paste the files.
5. Using your favorite text editor, open the NewY ork.prj file.

6. Change the PRECIP_FILE and XYBDYINPUT OVDEPTHINTERP card values to
the two files you just copied into the folder.

OUTLET HYDRO "HewYork.otl"

PRECIP FILE "SandyForecastRainfall.txt"™
EATHN INV DISTANCE

INIT ELEV_HEAD 0.15

OVERLOLND MOMENTTM
XYBDYINPUT OVDEPFTHINTERF "Sandy ADCIRC Surge Elevation Adv23.txt"

7. Change the TOT TIME from 960 to 1560.

RCWS 835
CCLS 951
TOT TIME 15a0
TIMESTEF 2
CUTRCW 512
CUTCOL 20

8. Save the file. You are now ready to run the forecast.

7 Hurricane Sandy Hindcast Model

The Hurricane Sandy model was built by adjusting the Hurricane Irene model to match the
rainfall and storm surge conditions of Sandy. We’ll work through the same process for the
hindcast data. Start by copying our recent changes to Irene to the NewYork Sandy Hindcast
folder.

9. Inthe Workspace/NewYork Irene folder, select and copy (CTRL-C) three files:
NewYork.prj, NewYork.cmt, and Irene _surge Adv25 xyts.txt.

HA Training » FY22 » HurricaneSandy * HurricaneSandy * Workspace » MewYork_Irene

Name Date medified Type Siz

=] Irene_surge_Adv25_xyts.bet /26/2011 T:02 PM Text Decument

g
|| IreneRainfall_Aug26Est.gag g GAG File

|| MewYark.cmt 8 CMT File

|| MewYark.ele g ELE File

Bl NewYork.map g Linker Address Map
|| MewYark.msk g MSK File

[ NewVark.prj 8/ PRI File

|| MewYark.sto 8 STO File

[0 NewYork.wms 8/209/2022 1:24 PM Windows Media P...

10. In the Workspace/ NewYork Sandy Hindcast folder, past (CTRL-V) the three files.
When you are asked to replace or skip the files, choose replace.
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"4 Replace or Skip Files = X

Copying 2 items from NewYork_Irene to NewYork_Sandy

The destination already has a file named "NewYork.prj”

~ Replace the file in the destination
2 Skip this file

44 Compare info for both files

More details

11. Now we’ll change the names of the rainfall and surge files:
|| NewYork_pc.tst B LY LULE 1328 B I

| | MewYork_prj.pro 8/209/2022 1:24 PM Pl
|=| Sandy_surge_sxyts.bet 8/26/2011 7202 PM Te
| | SandyRainfall.gag 8/26/2011 8:38 PM G
| | unif.idx 8/29/2022 1:24 PM IC

T umif landid idv 32 R2G52023 124 PRA r

12. Using your favorite text editor, edit the NewYork.prj file. Change the files names
after PRECIP_FILE and XYBDYINPUT OVDEPTHINTERP to match the new
“Sandy” names.

CUTLET HYDRO "HewYork.otl™
FRECIF FILE "SandyRainfall.gag"™
RATN THV DISTANCE

INIT ELEV HEAD 0.15

CVERLAND MOMENTUM
XYBDYINPUT CVDEPTHINTERF "Sandy surge =yts.txt"”

13. Change the TOT TIME from 960 to 1560.

7.1 Creating the Hindcast Rainfall

Now we have the file structure correct for the Hurricane Sandy project. We need to edit the
rainfall and the storm surge. First, we’ll edit the rainfall.

1. Switch back to WMS, or open a new WMS and read in the project if you closed
WMS. If you have the grid lines still turned on from before, in the = Display
|E 2D Grid Data oy Grid, toggle off the [ICels  cells. Click OK.

2. You’ll notice in the data tree the rainfall coverage is still called “Irene Rainfall”
because we haven’t changed the name of the event in the rainfall file yet. Right-click
on the “Irene Rainfall” coverage and select “Zoom to Layer”.

Options, under
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GSSHA — Hurricane Sandy

|
Zoom To Layer

You’ll notice that the “East Side” gage is off the tip of Long Island, while the “West

Side” is west of they harbor in New Jersey.

elevation (glev]

3. Using your favorite spreadsheet app, open the “SandyRainfall.gag” file. You’ll likely
need to import the data and use a “text to columns” feature. You can use a

“delimited” format with a tab delimiter.
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Text Import Wizard - Step 2 of 3 ? X
This screen lets you set the delimiters your data contains. You can see how your text is affected in the
preview below.
Delimiters
Tab
[] semicalon
[] Comma
[igpace:
[] other:

[] Treat consecutive delimiters as one

Text qualifier: | {none} v

Data preview

EVENT ["Irens Rainfall"

REDS [LE

REAG [

0ORD [E13300 485200
0ORD [TES100 552600

Select “Finish”.

"West Side"
"East Side"

Cancel < Back Hext > Einish

We need to adjust the date/time values as well as the rainfall values. Here is a good
reference: https://www.weather.gov/phi/sandyreport. The rainfall totals were much

less than Irene, with roughly 2 of rainfall on the east side, and '4” of rainfall on the
west side. We’ll start the time at 0100 UTC on the 29" of October 2012 and go

through 3am on the 30th.

*  Adjust the date/times, adding rows as needed. Once you have the right
number of rows, change the NRPDS value to match the number of rows of

date/time data you have.

*  Adjust the rainfall rates to be more similar to the Sandy imagery. The storms
came in pulses, with more rainfall (roughly 2”°) on the west than the east

(roughly '5™).
* Change the name to “Sandy Rainfall”
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A B C D E F G H
1 |EWMENT  "Sandy Rainfall”
2 |NRPD3 7
3 |NRGAG 2
4 |COORD 513300 4485200 "WestSide"
5 |COORD 769100 4552600 "East Sided"
& |RATES 2012 10 29 1 0 2 5
7 |RATES 2012 10 29 2 0 O 0
4 |RATES 2012 10 29 3 0 2 5
9 |RATES 2012 10 29 4 0 O 0
10 |RATES 2012 10 29 5 0 2 5
11 |RATES 2012 10 29 & 0 O 0
12 |RATES 2012 10 29 7 0 2 5
13 |RATES 2012 10 29 B 0 O 0
14 |RATES 2012 10 29 9 0 2 5
15 |RATES 2012 10 29 10 0 O 0
16 |RATES 2012 10 29 11 0 2 5
17 |RATES 2012 10 29 12 0 O 0
18 |RATES 2012 10 29 15 0 2 5
19 |RATES 2012 10 29 14 0 O 0
20 |RATES 2012 10 29 15 0 O 0
21 |RATES 2012 10 29 16 0 O 0
22 |RATES 2012 10 29 17 0 O 0
23 |RATES 2012 10 29 18 0 O 12
24 |RATES 2012 10 29 15 0 O 12
25 |RATES 2012 10 29 20 0 O 0
26 |RATES 2012 10 29 21 0 O 0
27 |RATES 2012 10 29 12 0 O 0
23 |RATES 2012 10 29 23 0 O 0
29 |RATES 2012 10 30 0 0 O 0
30 |RATES 2012 10 30 1 0 O 0
31 |RATES 2012 10 30 2 0 O 0
32 |RATES 2012 10 30 3 0 O 0

5. Save the file as the SandyRainfall.gag file. You’ll want the “tab delimited” text file
option.

T [©= Documents > work > Briefings = GSSHA Training > HurricaneSandy > Workspace > NewYork_Sandy

| SandyRainfall.gag |

Text (Tab delimited) [*tet) - [ save
Moaore aptions...
] New Falder

6. Close your spreadsheet editor. Check the name of the file that was saved. If it is
“SandyRainfall.gag.txt” then delete the old .gag file and rename the new file to
“SandyRainfall.gag”.

[ INEWTUK_pI T Of £ UL 1iEH F IV PR rie
d Sandy_surge_xyts.bet 8/26/2011 7:02 PM Text Document
d SandyRainfall.gag 8/26/2011 &38 PM GAG File

d SandyRainfall.gag.bet 8/30/2022 12:00 AM Text Document
|j unif.idx 8/29/2022 1:24 PM |0 File

gl o s

a

PR PTATITE 4 TR PR (LS TE

7.2 Edit the Storm Surge Time Series

Similarly to the rainfall data, we’ll edit the storm surge data in a spreadsheet.
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1. Using your favorite spreadsheet app, open the “Sandy surge xyts.txt” file. You’ll
likely need to import the data and use a “text to columns” feature. You can use a
“delimited” format with both tab and space delimiters.

Text Import Wizard - Step 2 of 3 ? *

This screen lets you set the delimiters your data contains, You can see how your text is affected in the
preview below.

Delimiters
[11ab
|:| semicolon Treat consecutive delimiters as one
[1 comma - .
Text gualifier: ~
Dgther:
Data preview
”
565200 580500 [5S0500 (535400 |[556300 (613800 (672500 (653400 [73100
451200 M452100 M451000 @472100 B435€300 BH531€00 H455700 @E55€000 B54580
2011 23 a a 0.15 0.15 0.15 0.15 0.15
2011 232 a .5 .5 0.75 L
< >

Cancel « Back Finish

2. The X and Y values will be offset of their time series. While this doesn’t matter to
GSSHA, it will help readability if we adjust them over. Just cut and paste the X and
Y values over the columns of data.

A B © D E F G H J K L M N

1 |XY_OV_DEPTH_INTERP
2 9

3 |x 569200 580500 590500 589400 596300 613800 672500 693400 773100
4y 4481200 4492100 4451000 4478100 4486300 4531600 4499700 4556000 4549800
5 2011 8 28 6 0 0.15 0.15 0.15 0.15 0.15 0.15 0.15 0.15 0.15
6 2011 g 238 8 0 15 15 0.75 1 1 0.15 15 0.15 0.15
7 2011 8 28 10 0 2.75 25 1.75 2 2 15 2 0.15 15
8 2011 8 28 12 0 3 3 1.85 25 25 1.75 25 1 15
9 2011 8 28 14 0 1.75 15 0.75 1 1 2 2 2 1
10 2011 8 28 16 0 0.15 0.15 0.15 0.15 0.15 2 0.15 2 0.5
1 2011 g 23 18 0 0.15 0.15 0.15 0.15 0.15 15 0.15 1.75 0.15
12 2011 8 28 20 o 0.15 0.15 0.15 0.15 0.15 0.15 0.15 1 0.15
13 2011 8 28 2 ] 0.15 0.15 0.15 0.15 0.15 0.15 0.15 0.15 0.15
14 2011 8 29 0 0 0.15 0.15 0.15 0.15 0.15 0.15 0.15 0.15 0.15

The format is straight-forward. The first line is the file type identifier,
“XY_OV_DEPTH_INTERP”. The second line is the number of different locations.
The remaining lines are Year Month Day Hour Minute [data values].

We will need to re-make this entire file. Starting from the right format, however, will
make the process much simpler.

3. Obtain storm surge data.

OPTION A: Access the CERA website (https://cera.coastalrisk.live/) and download
data. If you have access to the CERA historical data, or live data if you are modeling
a current storm, you can use their interface to select locations and download the
corresponding ADCIRC modeled data. Select the forecast/hindcast data set you
want, and then select a set of points, one by one, that covers the spatial changes in
the harbor area well. For each point you’ll need to click on the download link.
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Coastal Emergency Risks Assessment
St e

Virginia/Maryland «

i 2012-SANDY ~

Maximum Water Height above MSL (model start: 23-0¢1-2012 00:00, end: 30-0¢1-20'12 00:00 UTC)
Hurricane SANDY Track & Wind: NHC Best Track

E b div | Piease ahways check with yous regional National Wenther Service for the official forecast. |

i?a'hmay @ WD ISLAMD

()

SHEEPSHEAD
BAY
ROCKAWAY
BEACH:

e Carterel saGHTCN 5

2 @
Pleasant Plaing
B ;
b= parth Amboy
Keansburg
Keyport
__ Hazlet BELFORD
@
old Bridge Motetan
3} BRIDGE
[}
']
2
i Water Helght (ft, MSL) for location 40 425344.-74.013459

Maximum Water Height over the modal hindcast time range: 11.93 ft

Elevation: -17.21 ft balow MSL
L L. VOt
You’ll end up with a set of files that looks like this:

Lat40.371961_Lon-73.847281 json
Lat40.425666_Lon-74.010452 json
Lat40.4785%4 | on-74.243%12 json
Lat40.508203_Lon-74.004358 json
Lat40.525584_Lon-74.117368 Json
Lat40.571865_Lon-73.776%93 json
Lat40.581315_Lon-74.037918 json

CERA_MaxWaterElevation_Lat40.525584_Lon-
CERA_MaxWaterElevation_Lat40.571865_Lon-
¢ CERA_MaxWaterElevation_Lat40.391315_Lon-

ricaneSandy » Data » SandyData » ADCIRCDownloadData v
Mame D
i CERA_MaxWaterElevation_Latd0.371961_Lon-73.947281_TimeRan ge-2012102300-20121030... &/
CERA_MaxWaterElevation_Lat40.423666_Lon-74.010432_TimeRange-2012102300-20121030... &
CERA_MaxWaterElevation_Lat40.478394_Lon-74.243912_TimeRange-2012102300-20121030... &
CERA_MaxWaterElevation_Lat40.308203_Lon-74.004939_TimeRange-2012102300-20121030... &

74.117569_TimeRange-2012102300-20121030...
73.776993_TimeRange-2012102300-20121030...
74,037918_TimeRange-2012102300-20121030...

o

©0

Once you have the files downloaded you’ll want to extract the “.json” files from the
zip archive.
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Notice that in the file name is the lat/lon coordinate of the point.

OPTION B: Use the already downloaded data in the
Data/SandyData\ADCIRCDownloadData folder.

4. For the remainder of this exercise, we’ll complete the spreadsheet of the downloaded
data. The spreadsheet is in the Data\SandyData\ADCIRCDownloadData

5. Use WMS to do a coordinate conversion from Geographic NAD83 to UTM Zone
18N.

A. In WMS, use the Edit | Single Point Reprojection option to bring up the
reprojection dialog.

Edit Display Data Grids G55HA Hyd

Units

s % DL e 1)

Beproject...

Single Point Reprojection...

Materials...

Preferences...

5% Copy To Clipboard Ctrl+C

[=]

[El Paste

RN R P, I,

L

1

B. In the Reprojection dialog, on the “Convert From” side, select “Global
Projection”. Select the “Set Projection” button and choose the
“GCS_WGS 1984 (Latitude/Longitude)” option. If it doesn’t appear in the
recent projections, you can find it under Geographic Coordinate Systems,
World, WGS 1984. Select OK to close the Horizontal Projection dialog box.

Convert from @ Horizontal Projection X
Hoiizontal
(O Mo prajection Units: | Meters Favorite Projections
- ~ Recent Projections
@) Global projection Set Projection. NAD 1923 UTM Zone 12N
e NAD 1983 UTM Zone 18N P
i NAD_1983_UTM_Zone_18N UTM Zone 10, Northern Hemisphere
GCS_WGS_1984 (Jatitude/longitude)
LA Geographic Coordinate Systems
PROJCS['MAD_1963 UTM_Zone 18" GEQGCS 9rap ' ¥
["GCS_Morth_American_1983" DAT LM Projected Coordinate Systems

["D_Morth_American_1982" SPHEROID
["6RS_1980" 6378137.0,298.257222101]] PRIMEM[ " Greenwich" 0 1l
"D egiee".0.01 745329251 9433]LPROJECTION
["Transveise_Mercator L PARAMETER

Vool Filter strings: |
Add projection from: | EPSG code... | | .prj file... Library... | |Edited Parms...
Datum: | Local ~ | Unitss Meters Projection name:
GCS_WGS_1984 (atitude/longitude)
WKT:
GEOGCS['GCS_WGS_1984" DATUM['WGSS4", SPHEROID[ WGS84",
B Gemeielen Mew Coordi | 5378137,298, 257223563]], PRIMEM[ Greenwich”,0] UNIT[Degree”,0.017453232519943295]]
. Heb.. Coea
elp.

C. On the “Convert To” side, select “Global Coordinate System” as well. Make
sure NAD 83 UTM Zone 18N comes up.
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Conwert to
Harizontal
) Mo projection Uritz;  Meters
{®) Global projection Set Projection...
Frojection name: ~

MHAD_1333_UTM_Zone_18M

WET:

PROJCS["NAD_1983_UTH_Zone_18N".GEOGCS
["GCS_Marth_Amercan_1983" . DATUM

["D_Morth_American_1983" . SPHEROID

["GRS_1980" B378137.0,.298.257 2221 01 [ PRIMEM[ " Greenwich 0.OLUNIT
["Degree" 0.0174532925193433]) . PROJECTION

["Transverse_Mercator| PARAMETER ]
Wertical
Datum: | Local ~ Unitz: | Meters ~

D. Put in the lat/lon values of the last file location and take note of the X/Y
values. Put the X/Y values in the “Sandy_surge xyts” worksheet in the
spreadsheet, cells L3 and L4. This should be the results:

Lat | -74.037918

Lon | 40.591315

X 581410.9

Y 4493835.5

E. From the JSON files, extract the data points. We’ll just finish the last file
and add the data to the spreadsheet. There are many ways of getting the
data. The important thing to note is that the data needs to be converted from
feet to meters. This sequence uses Excel.

*  Open the “Lat40.591315 Lon-74.037918.json” file in Excel.
* Select Column A.

e Do Text to Columns, with a delimeter of :

* Select Column B

e Do Text To Columns, with a delimiter of “

« Delete rows 1 to 295 (this will make the first hour of the 29™ at the
top of the worksheet)

* Incell D2, type in the formula “=C2%*(0.3048”.
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j = =0.3048*C2

E C D E
2012-10-29 01
EI-.EE»E' 0. 2636521

2012-10-23 03
-1.029

*  Copy/paste this formula in column D in front of the other value in
the C column.

Jx

C ]

2012-10-29 01

0.865! 0.263651

o o o o

2012-10-29 03
-1.02% -0.31364

2012-10-29 05
-1.163 -0.35448

2012-10-29 07
0.637 0.1%416

e Select the D column.
¢  PressF5
*  Click on “Special”

Reference:

Special... |

* Select Blanks. Click OK.

Logicals
Errors

O Current region

() Current array

() Objects

*  On one of the selected blank cells, right-click and select Delete.
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L]

012- Delete

U&ebs| O Enlil

Paste Special...

2012-10-29(
-1.029| -0 Insert...
Delete...
2012-10-29(
-1.163 -0 Clear Contents

Select “Entire Row” and press OK.

Delete ? X

-1| () shift cells left
() Shift cells up
®)Entire row:

1 (::l Entire column

n172-

Select Column D.
Right-Click on D1 and Copy.
Rick-Click on D1 and Paste Special, values.

Paste Options:
(ol Ok

Add the backside of the storm surge curve:

Copy D11, paste to D13

Copy D10, paste to D14

Copy D9, paste to D15

Copy cells D1 to D15.

Switch to the Sandy Surge spreadsheet.

Paste in cell L5 in the Sandy Surge xyts worksheet.

F. The Sandy surge xyts worksheet should now be complete. It just needs to
be cleaned up of the extra data.

Erase the Lat and Lon values (E1 to L2)

Erase E3 and E4. It should now look like the
Sandy surge xyts done worksheet.
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& E o E F G L

1| v_ON_DEPTH_INTERP

2 7

3R 5833711 5533414 5640863 554304.1 5747436 B03520.7 5E51410.9
4 44635744 4475473.8 4481153.2 4434640.5 4436465.6 44531350.4 44338355
5 Zmz 10 23 1 1} 0.2353152 0.3zveda 0.3557016 0.2433264 0.2853504 01353664 0.Z63652
(3] 2012 10 23 3 0 -0.248412 -0.2642616  -0.2243424 -0.2516352 -0.2916936 -0.2862072 -0.3136332
7 2mz 10 23 5 0 -0.2734056 -0.5134304 -0.25176dE 03203448  -0.3273645 -0.3102564  -0.3544524
] zmz 10 23 T 1} 02633472 0.2127504 02764536 0.2185464 0.2136648 0.2328672 0.1341576
] Zmz 10 23 3 1} 0.3433656 0.333744 1.0514304 0.3518304 0.3857232 0.9144 0.3351744
0 2012 10 23 1 0 12316368 14176248 15243144 12351432 1.3516554 1177d424 130m312
il 2mz 10 29 13 1} 0.9119616 11533632 1.3483016 09723216 1.09728 0.783432 0.9506712
12 Zmz 10 23 15 1} 0.5307024 0.7352232 1103564 0.6453036 07571232 04666455 0.5650332
12 2012 10 23 17 0 11070336 1313685 1.8031365 11972544 13508736 10070932 11050712
14 2mz 10 29 13 1} 2.4426672 2.6395552 313182 2.6343864 2.7340432 2442972 25965912
15 zmz 10 23 21 1} 3.0547056 3633216 40763352 3.4635304 37255704 3.0184344 3.4856328
1€ 2012 10 23 23 0 3.0675072 34342272 4. 0663464 34502064 37261 3.080004 3.5271456
17 2mz 10 30 1 1} 3.0547056 3633216 4 0763952 346355354 37255704 30154544 34856925
18 2mz 10 30 3 1} 24426672 2.6395552 313182 2.6343864 2.7340432 2442972 2.5965912
L] Zmz 10 30 5 o 11070336 1313685 1.6031365 11372544 13508736 10070532 11030712

Q

Save the spreadsheet.

H. “Save As” the spreadsheet and change the type to Text (Tab Delimited).

" = Documents > work > Briefings > GSS...

Sandy_surge_xyts

Excel Workbook (*.xlsx)

@ Save

Excel

Excel Macro-Enabled Workbook (*xlsm)
Excel Binary Workbook (*xlsh)

Excel 47- orkbook (*xls)

TRy AT
|'_-_.'-_.'3 b

Workbook [*axlsx)

CSV UTF-8 (Comma delimited]) (*.csv)
ML Data (*acml)
Single File Web Page (*.mht, *.rhtml)
Web Page (*.htrm, *.html]
Excel Ternplate (*.xltx)

Excel Macro-Enabled Termplate (*.xltm)

Ewcel 97-

STRTE

2003 Ternplate (*.xt)

Text (Tab delimited) (*.tct)
Unicode Text (*.tt)

%y

XML Spreadsheet 2003 (Fxml)

I.  Change the folder to the Workspace\NewYork Sandy Hindcast folder.

J. Select Yes to replace the file.

ate modified

/2022 3:32 AM

K. Select OK when Excel warns you that it can only save the active worksheet.

6. You can now exit Excel and run the Hurricane Sandy GSSHA model.
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